
Adobe Photoshop CC  
14.2 update

Welcome to the latest Adobe Photoshop CC bulletin update. 
This is provided free to ensure everyone can be kept up-
to-date with the latest changes that have taken place in 
Photoshop CC. 
	 This bulletin describes the latest changes to the main 
Photoshop program. For a complete description of how to 
use these new Photoshop tools, with diagrams and step-by-
step tools, I recommend you buy the Adobe Photoshop CC 
for Photographers book.
	 The 14.2 update contains some significant new features, 
such as linked Smart Objects and Perspective Warp, as 
well as minor improvements such as a performance boost 
to the  Smart Sharpen filter (thanks to GPU support via the 
Mercury Graphics Engine) plus support for the new Mac Pro 
computers.
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Narrow Tool Options bar
If you go to the Interface preferences (shown in Figure 1), 
there is a new option to ‘Enable Narrow Options Bar’. The 
default option is for this to be set to ‘Off’. When enabled and 
you restart Photoshop, all check boxes and radio buttons in 
the Options bar will instead be displayed using Widgets (see 
Figure 2). The reason for this is to make the Options bar more 
visible for users who are working with localized versions of 
Photoshop on smaller displays.

Figure 2 Here you can see above, the standard Options bar and below it a narrow 
Options bar. In this example, the ‘Show Transform Controls’ check box has been 
replaced by a widget. You can roll the mouse over to see a helpful reminder.

Figure 1 This shows the Interface preferences dialog, where the ‘Enable Narrow 
Options bar’ option has been checked.
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Linked Smart Objects
Smart Objects were first introduced to Photoshop with 
version CS2. These allow you to place a raster or raw image 
as an embedded smart object in the image that can be edited 
independently of the master image. For example, when placing 
as a smart object, or converting an existing layer to a smart 
object you can resize the object in the master image without 
resizing the original. Smart Objects can also be used to apply 
smart filters, where the filter effects remain fully editable.

This latest update allows you to link to an external file that can 
be edited independently and updated in Photoshop and will 
work with all the usual supported file formats, including raw 
files. You can now have smart objects that are either embedded 
(as before), or linked (new to Photoshop CC). However, images 
that use linked Smart Objects must be saved using the PSD 
format. The Layers panel now shows these two kinds of Smart 
Objects using different icons. Figure 3 below, shows examples 
of these.

Figure 3 This shows a Layers panel view of a layered image that uses Smart 
Objects. Here you can see that the Background layer was converted to an embedded 
Smart Object so that I was able to apply a Blur Gallery filter effect as a Smart Filter. 
The selected layer and the layer below it are linked Smart Object layers, which means 
the layer contents are linked to an external file. The Layers panel view on the left 
shows the normal ‘updated’ state. The one in the middle where the linked file has been 
altered externally and needs updating. The one on the right shows the Smart Object 
file it links to is missing.

XMP sidecar files
With linked smart objects there is support 
for XMP sidecar files when linking to ACR 
files.
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Creating linked Smart Objects
To create a linked Smart Object, you can A-drag an image 
document from the Finder/Explorer, or from Bridge to an 
open image document in Photoshop. This places the dragged 
document as a layer, where you will see a placed image 
bounding box. Click E to confirm and create a linked Smart 
Object. You will then see the Smart Object layer appear in 
the Layers panel as a linked Smart Object (see Figure 3). This 
particular image was constructed from the selected image 
shown at the top of the Bridge Content view in Figure 4, 
where the linked layers were created by A-dragging the two 
separate image documents below. 

If you go to the Status bar at the bottom of the application 
screen, or bottom of the image document window (Figure 5), 
there is a new option ‘Smart Objects’, which allows you to 
see the latest status for any smart objects in the current 
image. This indicates how many Smart Objects in an opened 
document are either missing or need to be updated. This is also 
available as a selectable option in the Info panel. Figure 4  The images used to create the 

image shown here with linked Smart Objects.

Figure 5  The status bar now has a Smart Objects option that shows the current status 
for linked Smart Objects.
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Once you have created a linked Smart Object, if you move 
or rename a folder or file the relative linking will be retained. 
When you click on a Smart Object layer, the Properties panel 
(Figure 6) provides information about the current Smart Object 
layer status, allowing you to click on the Edit Contents button 
to edit the original Smart Object layer/image, or click on the 
Embed button to convert a linked Smart Object to a regular 
embedded Smart Object. You can also change a Linked Smart 
Object to an Embedded Smart Object by choosing Layers ➯ 
Smart Objects ➯ Embed Linked, or Embed All Linked.
 
Resolving bad links
If a link is missing on opening you will see the dialog shown in 
Figure 7. This alerts you to any missing links Photoshop can’t 
find. Maybe the linked Smart Object has been deleted?

To update a bad link, click on the red question mark icon in 
the Properties panel and choose ‘Resolve broken link…’ from 
the menu. Alternatively, use a right mouse-click on the Smart 
Object layer in the Layers panel to open the contextual menu 
and select ‘Resolve broken link…’ from this menu. If you open 
a child Smart Object image directly, edit it and choose save, 
the parent image won’t update until you force it to do so (for 
example, by going to the Properties panel). If you open a child 
Smart Object image by double-clicking the Smart Object layer, 
the parent image will update automatically.

Figure 6  This shows a Properties panel 
view for the status of a Smart Object (linked 
or embedded).

Figure 7  This shows the missing assets dialog that will appear on opening a parent 
image and linked Smart Objects can’t be found.
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You can also create Smart Object layers via the File menu. 
Choosing File ➯ Place Linked will allow you to select an 
external file and link it to a file saved using the PSD file format. 
Choosing File ➯ Place Embedded will embed the file in the 
parent image. i.e the same behavior as used currently in 
Photoshop.

You can use the contextual menu (show in a figure 8) to 
resolve broken links and update them. The update process 
only modifies the current selected Smart Object (or duplicate 
thereof), rather than all linked Smart Objects. Choosing ‘Update 
All Modified Content’ updates all Linked Smart Objects in your 
file. You can use ‘Replace Contents…’ to change the source file 
used as a Linked Smart Object.

Figure 8  This shows the layers panel contextual menu for a selected layer with 
options for updating or replacing a linked Smart Object. 
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Figure 9  This shows the Layers panel view and new Smart Object filter options. The 
buttons highlighted above show the following filter options: Up to date linked Smart 
Objects, Out of date linked Smart Objects, Missing linked Smart Objects and Embedded 
Smart Objects. The Layers panel view on the right shows an example of a Layers panel 
filter search where I filtered for out-of-date linked Smart Objects.	

Up to date

Out of date Missing

Filter menu

Embedded

Layers panel searches
The search feature in the Layers panel can be used to find both 
Linked and Embedded Smart Objects. Figure 9 below shows 
the Smart Object filter options for the Layers panel. Basically, 
a search can be carried out to find up-to-date, out-of-date or 
missing Smart Objects, as well as Embedded Smart Objects.
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Perspective Warp
Perspective Warp provides a new way to warp photos in 
order to correct or manipulate perspective. It allows you to 
manipulate the perspective in parts of your image, while 
maintaining the original perspective in other parts.
You can find Perspective Warp under the Edit menu: Edit ➯ 
Perspective Warp and it is particularly well suited to images 
that have a lot of architecture, straight lines or flat surfaces.
	 One way to use this new tool is to correct the perspective 
of buildings in a photograph, where you wish to make a 
building’s perspective look more correct, but without distorting 
everything else in the image. The thing is, this only works 
if the building in question is fairly rectangular in shape. 
Anything with a pitched roof isn’t going to work, though the 
animated Perspective Warp help screens shown in Figure 10 
demonstrate how this tool can be applied to some architectural 
photographs where the building shape is irregular. You can 
also use the Perspective Warp feature to manipulate a layered 
object as I have shown over the following pages.
	 When you apply a Perspective Warp you will initially 
be working in the Layout mode (l) where the idea is to 
define the warp planes. You do this by clicking and marquee 
dragging to define the first warp plane and then click on the 
corner handles to adjust the shape. Subsequent warp planes 
can be added to define other object planes and these will 
automatically snap-align to the edges of other existing planes. 
Once you have done this you can click on the Warp button in 
the Options bar to access the Warp controls shown in Figure 11 
below.

Figure 10 When you first select the 
Perspective Warp you will see these helpful 
animated help dialogs. They go away after 
the first time you use Perspective Warp.

Figure 11 This shows the Perspective warp Options bar in Layout mode (l), at 
the top and Warp mode (w) at the bottom.

Enable Graphics Processor
To get Perspective Warp to work, make sure 
you have enabled the Graphics Processor 
in the Photoshop ➯ Performance 
preferences. In the Advanced Settings make 
sure Use Graphics Processor to Accelerate 
Computation is selected.

Automatically straighten 
near vertical lines

Auto warp to horizontal 
and vertical

Remove warp Commit warp

Cancel warp

Automatically straighten near horizontal lines
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1 To illustrate working with the Perspective Warp feature, I used the two photographs 
seen here. One is an empty room interior and the other, a photograph of a wooden box 
cabinet, which I had cut out using a pen path.

2 I placed the box as a layer in the Empty Room image document. As an optional 
step, I created a layer containing perspective grid guide lines, which I added here as 
a temporary layer and would use later to help guide the positioning of the box in the 
image.
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3 I went to the Edit menu and chose Perspective Warp. I began by marquee dragging 
over the box image layer to add the first quad plane.

4 I then clicked on the quad plane corner pins to fine-tune their placement and align 
with the first plane of the wooden box. You can also use the keyboard arrow keys to 
nudge a selected quad pin. 
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5 I then clicked and dragged to add a second quad plane. You will note as you do this 
how when the second plane edge meets the first the two edges are highlighted blue and 
the second plane snaps to the edge of the first. After doing this I fine tune adjusted the 
corner pin positions of the second quad plane. Note you can Hold down the C (Mac) 
L (PC) key while drawing quads to place them close but without joining.

6 I added a third quad plane to define the top of the box. I then clicked on the Warp 
button (w) in the Options bar to prepare the layer for warping. You can also use the 
h key to hide the grids when working in the Warp mode.
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7 I clicked on the quad plane corner pins to move them and create a new perspective 
for the layer object. You will notice how if you hold down the S key as you click 
on a segment between two pins the segment turns yellow and will automatically snap 
to the horizontal, vertical, or a 45° angle (S click again to disable).

8 Lastly, I clicked Enter to OK the Perspective Warp adjustment. I then removed the 
perspective guides layer and carried out some further retouching to change the color 
of the top of the box and add some shading beneath it.
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Updated Windows Stylus and mouse tracking support
Stylus support on Windows OS for non-Wacom devices 
has been updated, especially targeting new tablet-based 
computers that use n-trig tablet technology. As part of this 
work the mouse tracking code has also been updated to take 
advantage of modern OS APIs. These changes include some 
performance tweaks which should speed up painting and other 
input device interactions. 

Codeathon JDIs
At the 2013 Photoshop World in Las Vegas, Adobe assigned a 
team of Photoshop engineers, including Russell Williams, Tai 
Luxon and Stephen Nielson to carry out a live coadeathon on 
the show floor. Photoshop users were able to stop by to make 
suggestions about things they would like to see in Photoshop 
and the engineers were able to work directly on the code to 
show how these could be implemented into the program. 
Now that Photoshop CC can be updated more frequently, the 
following JDIs (just do it) have been added to Photoshop.
	 Whenever you wanted to convert a Background layer to 
a regular layer you would previously have had to select the 
Background layer, go to the Layer menu and choose New ➯ 

Layer from Background… Now, you can do all this by simply 
clicking on the Background layer lock icon (see Figure 12).
	 In the New Document dialog you can set a custom color 
as the background color. The Background Content menu now 
features an Other… option. When this is selected it opens the 
Color picker, allowing you to select a custom color.
	 The Swatches panel now allows you to see the most 
recently selected colors. In Figure 13 you can see a new bar of 
swatches that runs across the top of the panel. This is used to 
display in sequence, the most recently sampled swatch colors. 
This can be useful because it means you can make a series 
of color samples by clicking with the eyedropper tool and 
these will automatically be added to the Swatches panel ready 
for use in the same or another document. You don’t have to 
explicitly save the swatches, semi-permanently adding them to 
a swatch collection. This is now a tidier solution.

Figure 12  A click on the Background 
layer lock icon converts it to a regular layer.

Figure 13  This shows the Swatches 
panel showing the most recent selected 
swatch colors.
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Figure 14  You can now have up to 10 color sampler readouts in the Info panel.

	 You can now have up to 10 color samplers in the Info panel, 
instead of just 4. Figure 14 shows an example of the Info panel 
with 10 color sample readouts. You can change the color mode 
of each of these by clicking on the eyedropper icon next to 
each (see Figure 13). Also, if you hold down the A key as you 
do so, you can change the color mode for all the color sample 
readouts. Meanwhile, the Tool Options bar for the color sampler 
tool has changed the “Clear” button to now say “Clear All”.

Better negative number support in Curves
When applying a Curves adjustment and editing an image in 
Lab color mode, it is now possible to enter triple digit numbers 
directly into the fields in the Curves dialog. Previously, you 
could only type in two digital negative numbers, or three digit 
positive number values.


